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Abstract

These Application Notes describe the steps to configure Session Initiation Protocol (SIP)
Trunking for an enterprise solution using Avaya IP Office 10.0 to interoperate with the
Vodafone DE SIP Trunk Service.

The Vodafone DE SIP Trunk Service provides PSTN access via a SIP trunk connected to the
Vodafone DE Voice Over Internet Protocol (VolP) network as an alternative to legacy analog
or digital trunks. This approach generally results in lower cost for the enterprise. Vodafone
DE is a member of the Avaya DevConnect Service Provider program.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps to configure Session Initiation Protocol (SIP)
Trunking for an enterprise solution using Avaya IP Office 10.0 to interoperate with the VVodafone
DE SIP Trunk Service.

The Vodafone DE SIP Trunk Service referenced within these Application Notes is designed for
business customers. Customers using this service with the IP Office solution are able to place
and receive PSTN calls via a broadband WAN connection using the SIP protocol. This
converged network solution is an alternative to traditional PSTN trunks such as analog and/or
ISDN-PRI trunks. This approach generally results in lower cost for the enterprise.

2. General Test Approach and Test Results

The general test approach was to connect a simulated enterprise site via the public Internet and
exercise the features and functionality listed in Section 2.1. The simulated enterprise site was
comprised of Avaya IP Office and various Avaya endpoints listed in Section 4.

The Vodafone DE SIP Trunk Service passed compliance testing with observations/limitations
described in Section 2.2.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

Avaya recommends our customers implement Avaya solutions using appropriate security and
encryption capabilities enabled by our products. The testing referenced in this DevConnect
Application Note included the enablement of supported encryption capabilities in the Avaya
products. Readers should consult the appropriate Avaya product documentation for further
information regarding security and encryption capabilities supported by those Avaya products.

Support for these security and encryption capabilities in any non-Avaya solution component is
the responsibility of each individual vendor. Readers should consult the appropriate vendor-
supplied product documentation for more information regarding those products.

For the testing associated with this Application Note, the interface between Avaya systems and
the Vodafone DE SIP Trunk Service did not include use of any specific encryption features as
requested by Vodafone DE.

Encryption (TLS/SRTP) was used internal to the enterprise between Avaya products with
limitations (see Section 2.2). Some sanity testing was performed to verify that an unencrypted
enterprise (TCP/RTP) was a valid workaround for G.729 calls described in Section 2.2.
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2.1. Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were covered
during the interoperability compliance test:

Establishment of the SIP trunk.

SIP OPTIONS queries and responses.

Incoming PSTN calls (via the SIP trunk) to SIP and H.323 telephones at the enterprise.
Outgoing PSTN calls (via the SIP trunk) from SIP and H.323 telephones at the enterprise.
Inbound and outbound PSTN calls to/from Avaya Communicator for Windows and
Avaya Communicator for Web.

Various call types including: local, long distance, international, outbound toll-free,
operator, and local directory assistance.

Codec G.711A and G.729.

Caller ID presentation and Caller ID restriction.

DTMF transmission using RFC 2833.

Response to incomplete call attempts and trunk errors.

Voicemail navigation using DTMF input for inbound and outbound calls.

Voicemail message waiting indicator (MWI).

User features such as hold and resume, internal call forwarding, transfer, and conference.
Off-net call forwarding and twinning (mobility).

G.711 fax.

Long duration calls and simultaneous active calls.

Remote worker.

The following items are not supported or were not tested:

The REFER method and T.38 Fax are not supported by the VVodafone DE SIP Trunk
Service.
Inbound toll-free calls and emergency calls were not tested.

2.2. Test Results

Interoperability testing of the Vodafone DE SIP Trunk Service was successful with the following
observations.

Outbound Caller ID: On outbound calls, the calling party number is shown as the
pilot/base number of the account and not the actual DDI sent by Avaya IP Office. The
trunk was configured by Vodafone DE with a length that was longer than the set of
numbers provided for testing. In this case, it is expected behavior that the pilot/base
number is used as the calling party.

Call Forward and Caller ID: For inbound PSTN calls that are call forwarded to another
PSTN endpoint, the forwarding party number is shown as the calling party instead of the
original PSTN caller (forwarded party). This also impacts enterprise users with Twinning
(mobility) enabled. These users have their inbound calls also ring a mobile phone. On the
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mobile phone, the enterprise host number is shown as the calling party instead of the
original PSTN caller.

e (.711 fax: Some G.711 fax calls failed due to excessive jitter on the trunks used in the
test environment.

e (.729 and SRTP: Inbound or outbound calls from an Avaya 96x1 H.323 phone to the
PSTN using G.729 and encrypted media inside the enterprise results in one-way audio in
the outbound direction from the enterprise. On an outbound call with G.729 selected,
Vodafone requests a ptime of 30 and cannot be changed on a per customer basis.
Inbound calls requests a ptime of 20 but the failure is the same. This issue is believed to
be an issue with the Avaya 96x1 H323 phone. The issue has been raised to the Avaya
development team and is under investigation. Other phone types tested (Avaya 16xx
H.323 and Avaya 11xx SIP phones) did not have this issue. Workarounds include one of
the following:

- Do not use G.729 on the trunk to VVodafone DE (Section 5.5.6).
- Do not use encryption TLS/SRTP internal to the enterprise (Sections 5.3.1 for
signaling, and 5.3.4 for media).

2.3. Support

For technical support on VVodafone DE products please visit the website at www.vodafone.de or
contact an authorized VVodafone DE representative.

For technical support on the Avaya products described in these Application Notes visit
http://support.avaya.com.

3. Reference Configuration

Figure 1 illustrates the sample configuration used for the DevConnect compliance testing. The
sample configuration shows an enterprise site connected to the Vodafone DE SIP Trunk Service.

The enterprise site contains an Avaya IP Office 500 V2 with various endpoints and a Windows
PC running both Avaya IP Office Manager to configure Avaya IP Office and Avaya VoiceMail
Pro for voicemail. In addition, the Avaya IP Office Application Server is present to support use
of Avaya Communicator for Web (WebRTC client). For the compliance test, Avaya IP Office is
deployed in a 2-port configuration. The Avaya IP Office LAN1 port is connected to the private
enterprise LAN and the WAN (LAN2) port is connected to the public network.
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Figure 1: Avaya Interoperability Test Lab Configuration

For security purposes, any public IP addresses or PSTN routable phone numbers used in the
compliance test are not shown in these Application Notes. Instead, public IP addresses have
been replaced with private addresses and all phone numbers have been partially masked or
replaced with numbers that cannot be routed over the PSTN.

For the purposes of the compliance test, users dialed a prefix digit 9 plus N digits to send an
outbound call to the number N across the SIP trunk to the service provider. The short code of 9
was stripped off by Avaya IP Office and the remaining N digits were sent to the service provider
network. For international calls, Avaya IP Office was configured to replace the dialed
international access code (00) with a + sign in the SIP headers (Section 5.5.8). In the source
headers (e.g., From, PAI, and Contact), Avaya IP Office was configured to send the DDI number
assigned by Vodafone DE in international format (e.g., +496913xxxxxxx) (Section 5.7).
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The Vodafone DE SIP Trunk Service sends the destination number in international format (e.g.,
+496913xxxxxxx) in the Request-Line and the To header in an inbound SIP INVITE message.

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and the enterprise network such as a data firewall. A
complete discussion of the configuration of these devices is beyond the scope of these
Application Notes. However, it should be noted that SIP and RTP traffic between the service
provider and Avaya IP Office must be allowed to pass through these devices.

The administration of the Avaya Voicemail Pro messaging service and endpoints on Avaya IP
Office are standard. Since these configuration tasks are not directly related to the interoperation
with the Vodafone DE SIP Trunk Service, they are not included in these Application Notes.
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4. Equipment and Software Validated
The following equipment and software were used for the sample configuration provided:

Avaya Telephony Components

Equipment

Software

Avaya IP Office 500 v2

10.0 SP3 (10.0.0.3.0 Build 5)

Avaya IP Office Manager

10.0 SP3 (10.0.0.3.0 Build 5)

Avaya IP Office VoiceMail Pro

10.0 SP3 (10.0.0.3.0 Build 5)

Avaya IP Office Application Server
e 0ne-X® Portal
e WebRTC Gateway

10.0 SP3 (10.0.0.3.0 Build 5)
(10.0.0.3.0 Build 9)
(10.0.0.3.0 Build 10)

Avaya 1140E IP Deskphone (SIP)

4.4 SP4 (4.04.23)

Avaya 1616 IP Deskphone (H.323) running
Avaya one-X® Deskphone Value Edition

1.3.5 (1.3.50B)

Avaya 9641G IP Deskphone (H.323) running
Avaya one-X® Deskphone Edition

6.6.4 (6.6401)

Avaya Communicator for Windows

2.1.3 (2.1.3.237)

Avaya Communicator for Web 1.0.16.1718
Vodafone DE Components
Equipment Software
Oracle Session Border Controller 7.2
Italtel Softswitch 20.50.52

Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500 V2 and also when deployed with IP Office Server Edition in all configurations.

Avaya IP Office Server Edition requires an Expansion IP Office 500 V2 to support analog/digital

endpoints or analog/digital trunks.
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5. Configure Avaya IP Office

Avaya IP Office is configured through the Avaya IP Office Manager PC application. From the
PC running Avaya IP Office Manager, select Start - All Programs - IP Office - Manager
to launch the application. Select the proper Avaya IP Office system from the pop-up window,
and log in using the appropriate credentials.

Lo
File Edit View Tools Help

2E-d@EEL v H2

Dﬁ

MName IP Address  Type Version Edition

]|

Release 10.0
Atlantic City 10.32.128.25 IP500V2 10.0.0.3.0 build 3  IP Office

i

Configuration Service User Login

IP Office: Atlantic City (IP 500V2)

Service User Name |Admini5trat0r |

Service User Password |"uuuu| |

| oK | Cancel Help

TCP Discovery Progress

Unit/Broadcast Address

10.32.128.25 v Refresh Cancel

If the above screen does not appear, the configuration may be alternatively opened by navigating
to File = Open Configuration at the top of the Avaya IP Office Manager window.

The appearance of the Avaya IP Office Manager can be customized using the View menu. In the
screens presented in this document, the View menu was configured to show the Navigation pane
on the left side, omit the Group pane in the center, and show the Details pane on the right side.
Since the Group Pane has been omitted, its content is shown as submenus in the Navigation
pane. The Navigation and Details panes will be referenced throughout the Avaya IP Office
configuration. All licensing and feature configuration that is not directly related to the interface
with the service provider (such as twinning and Avaya Communicator support) is assumed to
already be in place.

In the sample configuration, Atlantic City was used as the system name. All navigation
described in the following sections (e.g., License = SIP Trunk Channels) appears as submenus
underneath the system name Atlantic City in the Navigation Pane.
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5.1. Licensing

The configuration and features described in these Application Notes require Avaya IP Office to
be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,

contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in
the Navigation pane. Confirm a valid license with sufficient Instances (trunk channels) appears

in the Details pane.

IP Offices |

=) v 3 >
8 BOOTP (3) License Remote Server
(4% Operator (3)
-5 Atlantic City License Mode License Mormal
g}‘;‘ E:i':;e(r;s]m Licensed Version 10.0
&< Control Unit (3) PLDS Host ID |:|
-4 Extension (23) . R
D___a User (27) PLDS File Status ~ Valid
(-3 Group (1)
E:l"'g zhor_t CDSE (65) Feature Instances Status Expiration Date Source G Add...
ol R:r;lae]( ) Receptionist 4 Valid Mever PLDS Modal
E]---@ Incoming Call Route (7 Additional Voicemail Pro Ports 152 Valid Mever PLDS Modal Remove
""" €2 WAN Port (0) VMPro Recordings Administrators 1 Valid Mever PLDS Modal
:::;ﬁ ?ii:;tgg‘fﬁz . Essential Edition Additional Voice.. 4 Valid Never PLDS Nodal
E]@ Firewall Profile (1) VMPro TTS (Generic) 40 Valid Mever PLDS Modal
-l 1P Route (4) Teleworker 384 Valid Mever PLDS Modal
----- & Account Code (0) Mobile Worker 384 Valid Mever PLDS Modal
----- LA License (30) Office Worker 384 Valid Mever PLDS Nodal
""" & Tunnel (0) Avaya Softphone Licence 100 Valid Mever PLDS Nodal
8{) ool ;'49]"“ @ VMPro TTS (Scansoft] 40 Valid Never PLDS Nodal
_____ i Location (0) VMPro TTS Professional 40 Valid Mever PLDS Modal
..... 28 Authorization Code (0) IPSec Tunnelling 1 Valid Mever PLDS Modal
Power User 384 Valid Mever PLDS Modal
HAvaya IP endpoints 384 Valid Mever PLDS Modal
IP500 Voice Networking Channels 32 Valid Mever PLDS Modal
SIP Trunk Channels 128 Valid MNever PLDS Modal |
IP500 Universal PRI (Additional cha... 100 Valid Mever PLDS Modal
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5.2. TLS Management

For the compliance test, internal to the enterprise, signaling was secured using TLS wherever
possible. Testing was done using identity certificates signed by a local certificate authority
SystemManager CA. The generation and installation of these certificates are beyond the scope
of these Application Notes. However, once the certificates are available they can be viewed on
the Avaya IP Office in the following manner.

To view the certificate currently installed on Avaya IP Office, navigate to File 2 Advanced 2
Security Settings. In the Security Settings window, navigate to Security - System and select
the Certificates tab.

To verify the identity certificate, locate the Identity Certificate section and click View to see the
details of the certificate.

File Edit View Help

Security Settings System: Atlantic City
= £ Security System Details  Unsecured Interfaces  Certificates
@ .
+--4% System (1) —
_,_@ Services (7) Offer Certfficate
+i3 F{jgh_ts Groups !:1 5 Offer |D Certificate Chain [
-y Service Users (6) lssued To: Atlantic_City
Set View Regenerate
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A pop-up window will appear showing that the certificate is issued to the Avaya IP Office
(Atlantic_City) and signed/issued by SystemManager CA. Click OK to close the pop-up
window.

n | Certificate >

Gereral Detailz Certification Path

E Certificate Information

This certificate is intended for the following purpose(s):

* Ensures the identity of a remote computer
* Proves your identity to a remote computer

| Issued to: Atlantic_City |

|]55ued by: SystemManager CA |

Valid from 2/21/2017 to 2/21/2019

Install Certificate... | | Issuer Statement

To verify the trusted certificates, return to the Security = System -> Certificates tab and scroll
down to the Trusted Certificate Store section. Verify that SystemManager CA is listed as an
Installed Certificate.

Trusted Certificate Store

Installed Certficates SystemManager CA
Symantec Class 3 Secure Server CA - G4
VeriSign Class 3 Intemational Server CA - G3
SIP Product Cerificate Authority

Add View Delete
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5.3. System

Configure the necessary system settings.

5.3.1. System — LAN2 Tab

In the sample configuration, the Avaya IP Office WAN port was used to connect to the public
network. The LAN2 settings correspond to the WAN port on the Avaya IP Office 500 V2. To
access the LAN2 settings, first navigate to System = <Name>, where <Name> is the system
name assigned to the Avaya IP Office. In the case of the compliance test, the system name is
Atlantic City. Next, navigate to the LAN2 - LAN Settings tab in the Details Pane. Set the IP
Address field to the IP address assigned to the Avaya IP Office WAN port on the public
network. Set the IP Mask field to the mask used on the public network. All other parameters
should be set according to customer requirements.

IP Offices ‘ :

B

=R BOOTP (4)
+-{# Operator (3)
=30 Atlantic City
=43 System (1)
-7 Line (27)
+ = Control Unit (4)
4
&

-4 Extension (25)
o8 User (27)
+:ﬂ Group (1)
+1-@% Short Code (65)
-~ Service (0)
e RAS (1)
+e Incoming Call Route (7
B2 WAN Port (0)
-4 Directory (0)
£ Time Profile (0)
+-{) Firewall Profile (1)
+-[lll IP Route (4)

= Atlantic City
SMDR. VCM  VolP VolP Security Contact Center
System LAN1 LAN2Z  Dns
LAN Settings  VolP Network Topology
IP Address 135 10 96 232
IP Mask 255 255 235 224
Primary Trans. IP Address 0 0 0 0
Firewall Profile <Mone>
RIP Mode None
[] Enable NAT

Number Of DHCP IP Addresses 200

DHCP Mode

Y

Voicemail Telephony Directory Services System Events  SMTP

i~ Account Code (0) () Server () Client () Dialln (® Disabled Advanced

il | jrenee (300
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On the VoIP tab in the Details Pane configure the following parameters:

Check the SIP Trunks Enable box to enable the configuration of SIP trunks.

Atlantic City

Contact Center

Systern  LAN1  LAN2Z  DNS  Voicernail Telephony Directory Services System Events SMTP SMDR VCM

VolP VolIP Security
LAM Settings VoIP Network Topology

[] H.323 Gatekeeper Enable

Auto-create Extension Auto-create User

H.323 Remote Extension Enable
Disabled 1720 =
SIP Trunks Enable
[] SIP Registrar Enable
Auto-create Extension/User SIP Remote Extension Enable

upp = =
TCP S S
TLS 5061 = =

1

RTP

Port Number Range

Minimum 49152 = Maximum 53246 =
Port Mumber Range (MAT)

Minimum 49152 = Maximum 53246 =

Avaya H.323 and SIP phones connect to the Avaya IP Office LANL1 interface (not LAN2). The
settings for LANL1 are not included in these Application Notes since they are not directly related
to SIP trunking. However, if it is desired to disable TLS/SRTP on the phones to avoid the issue
with Avaya 96x1 H.323 phones with G.729 and SRTP documented in Section 2.2, then perform

the following on the VoIP tab of the LANL1 interface (not shown) to disable TLS. To disable
SRTP, see Section 5.3.4.

e Set H.323 Signaling over TLS to Disabled.
e Under Layer 4 Protocol, uncheck the TLS box.
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To continue the configuration of the LAN2 = VolP tab, scroll down the page.

e Inthe Keepalives section, set the Scope to RTP-RTCP. Set the periodic timeout to 30
and the Initial keepalives parameter to Enabled. These settings will cause Avaya IP
Office to send RTP and RTCP keepalive packets starting at the time of initial connection
and every 30 seconds thereafter if no other RTP/RTCP traffic is present. This facilitates
the flow of media in cases where each end of the connection is waiting to see media from
the other, as well as helping to keep firewall ports open for the duration of the call.

e All other parameters should be set according to customer requirements.

= Atlantic City [ v <>

Contact Center

System LAN1  LANZ  DNS Voicemail Telephony Directory Services System Events SMTP SMDR VCM  VolP VolP Security

LAN Settings  VolP Network Topology

Enable RTCP Monitoring on Port 5003

RTCP cellecter IP address for phones 0 0 0 0

Keepalives

Scope RTP-RTCP ~ | Periodic timeout
Initial keepalives Enabled ~

DiffServ Settings

B8 3] DSCP(Hex) B2 [T VideoDSCP (He) FC [ DSCPMask (Hed) 88 |3 SIG DSCP (Hex)

46 |7 Dscp 46 2| Video DSCP 63 |2 DSCPMask M 2 SIGDsCP

DHCP Settings

Primary Site Specific Option Number (350N) 178 =

Secondary Site Specific Option Number (S50N]) 242 =

VLAN Mot Present ~

1100 Vieice VLAM Site Specific Option Number (S50N) 232 =

1100 Voice VLAN IDs

No configuration was necessary on the LAN2 = Network Topology tab for SIP Trunking since
the SIP Line = Transport tab has the Use Network Topology Info field set to None (Section
5.5.3).
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5.3.2. System - Telephony Tab

To access the System Telephony settings, navigate to the Telephony - Telephony tab in the
Details Pane.

e Choose the Companding Law typical for the enterprise location. For the compliance
test, A-Law was used for both Switch and Line.

e Enter or select 0 for Hold Timeout (sec) so that calls on hold will not time out.

e Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and
call transfer to the PSTN. If for security reasons incoming calls should not be allowed to
transfer back to the PSTN then leave this setting checked.

e All other parameters should be set according to customer requirements.

o

= Atlantic City [ ) v | <] =

Contact Center
System LANT  LAN2Z  DNS Voicemail Telephony Directory Services System Events  SMTP  SMDR  VCM  VolP VolP Security
Telephony = Park & Page Tones & Music  Ring Tones  SM CallLog TUI

Analogue Extensions Companding Law .
Switch Line
Default Outside Call Sequence Normal ~
Default Inside Call Sequence Ring Type 1 w O u-taw U-Law Line
Default Ring Back Sequence Ring Type 2 v
A-Law A-Law Line
Restrict Analogue Extension Ringer Voltage [l @ ®
Dial Delay Time (sec) 4 = [] DSS Status
Py ] Aute Hold
Dial Delay Count 0 - e e
. = Dial By Mame
Default Mo Answer Time (sec) 25 = B
- = Show Account Code
Hold Timeout (sec) 0 >
= | |:| Inhibit Off-Switch Forward,/ Transfer
Park Timeout (sec) 300 o
= [1 Restrict Metwork Interconnect
Ring Delay (sec) 3 o
- Include location specific information
Call Prigrity Promotion Time (sec) Disabled =
[] Drop External Only Impromptu Conference
Default Currency usD ~
[ Visually Differentiate External Call
Default Mame Priority Favor Trunk ~
[] Unsupervised Analog Trunk Disconnect Handling
Media Connection Preservation Disabled ~ ) ) )
High Quality Conferencing
Phone Failback Manual - o
Digital/Analogue Aute Create User
Login Code Complexity O
Directory Overrides Barrin
] Enforcement v g
4 = [1 Advertise Callee State To Internal Callers
Complexity
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5.3.3. System - VolIP

For the compliance test, all codecs were checked under Available Codecs and all were moved to
the Selected group using the arrow buttons. The group of Selected codecs are the codecs which
are available to the system for use. The list can be further restricted for the SIP trunk on the SIP
Line = VoIP tab (Section 5.5.6). The RFC2833 Default Payload was left at the system
default of 101. Vodafone sends 106 as the payload value. For each call, the payload value was
negotiated to 101 or 106; both values were used successfully.

W

= Atlantic City ) v | < | =

System LAMNT  LAMZ  DNS Voicemail Telephony Directory Services  System Events  SMTP SMDR
viom o VelP WolP Security  Contact Center

Ignore OTMF Mismatch For Phones ]

Allow Direct Media Within NAT Location [

RFC2833 Default Payload 101 =
Avsailable Codecs Default Codec Selection

Unused Selected
G.717 ULAW 64K S G.717 ULAW 64K
G.717 ALAW 64K G.717 ALAW 64K
G.722 64K (G.729(a) 8K C5-ACELP
(G.729(a) 8K C5-ACELP G.723.1 6K3 MP-MLO
G.723.1 6K3 MP-MLC o G.722 64K
S
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5.3.4. System — VoIP Security

For the compliance test, SRTP was used internal to the enterprise wherever possible. Thus, the
Media parameter was set to Preferred, specifying that SRTP is preferred before RTP. One way
to avoid the issue with Avaya 96x1 H.323 phones using SRTP and G.729 documented in Section
2.2 is to set the Media parameter to Disabled. This will disable the use of SRTP to the
enterprise phones. If SRTP is disabled for media, then TLS should be disabled for signaling
(Section 5.3.1).

For the compliance test, Media was set to Preferred and the Media Security Options were set as
follows:
e Under Encryptions, check RTP.
e Under Authentications, check RTP.
e Under Crypto Suites, select SRTP_AES CM 128 SHAL1 80 and
SRTP_AES_CM_128 SHA1 32.
e Click OK to commit (not shown).

®

= Atlantic City £ v | <>

Systemm LANT  LANZ  DNS Voicemail Telephony Directory Services  System Events  SMTP SMDR
VCM Vol VolP Security  Contact Center

Media Preferred e [] Strict SIPS

Media Security Options

Encryptions RTP
1 rTcp

Authentication RTP
RTCP

Replay Protection

SRTP Window Size |64
Crypto Suites
SRTP_AES_CM_128_SHA1_80
SRTP_AES_CM_128_SHA1_32
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5.4. IP Route

A default route is needed so IP Office can reach other network subnets other than the one where
it resides. Since IP Office and the private side of the Avaya SBCE reside on the same subnet, the
default route is not specifically used for SIP Trunking. Navigate to IP Route - 0.0.0.0 in the
left Navigation Pane if a default route already exists. Otherwise, to create the default route,
right-click on IP Route and select New. Create/verify a default route with the following

parameters:

e Set IP Address and IP Mask to 0.0.0.0.

e Set Gateway IP Address to the IP address of the default router on the network where
Avaya IP Office is connected.

e Set Destination to LAN2 from the drop-down list.

Click the OK button at the bottom of the page (nhot shown).

1

H-@% Short Code (63)

----- B Service (0)
Hadly RAS (1)

----- £8 WAN Port (0)
----- #s Directory (0)
..... £ Time Profile (0)

-l IP Route (4)

= 1]o.0.00

E]---e Incoming Call Row

[]---@ Firewall Profile (1)

[ Proxy ARP

IP Offices = 0.0.00 gk - X v <>
=-& BOOTP (4) IP Route
#-4# Operator (3)
-9 Atlantic City IP Address 0 o o 0
E\"- Systemn (1)
L3 Atlantic City 1P Mask ° ] 0 ’
#-47 Line (27) Gateway IP Address 192 . 168 . %6 . 254
<= Control Unit (4)
48 Extension (25) Destination LAMZ ~
H-§  User (27 =
-4 Group (1) Metric 0
f

4
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5.5. SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and the Avaya
SBCE. The recommended method for configuring a SIP Line is to use the template associated
with these Application Notes. The template is an .xml file that can be used by IP Office
Manager to create a SIP Line. Follow the steps in Section 5.5.1 to create the SIP Line from the
template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses

e SIP Credentials (if applicable)

e SIP URI entries

e Setting of the Use Network Topology Info field on the Transport tab

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Sections 5.5.2 — 5.5.8.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls

Transport — Second Explicit DNS Server

SIP Credentials — Registration Required

SIP Advanced

Engineering

To create a SIP Line manually, right-click Line in the Navigation Pane and select New - SIP
Line; then, follow the steps outlined in Sections 5.5.2 — 5.5.8.
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5.5.1. SIP Line From Template

1. Copy the template file to the computer where IP Office Manager is installed. Place it in
an empty directory. This is important because Step 2 will import all templates located in
this directory not just the template file associated with these Application Notes.

2. Import the template into IP Office Manager. From IP Office Manager, select Tools >
Import Templates in Manager. This action will copy all the template files located in
the selected directory into the IP Office template directory and make the templates
available in the IP Office Manager pull-down menus in Step 3.

U™ Avaya IP Office Manager Atlantic City
File Edit VWiew | Tools | Help
8= a E Extension Renumber...
Atlantic City Line Renurnber...
Connect Ta... 1
IP O
Export [ 4
‘!‘ BOOTP (3) S5CM Service User Management Tl
[-i# Operator (3]
EI---’-;- Atlantic City Busy on Held Validation
-5 Systermn (1)
T3 Line (25) M5M Configuration
B2 Control Unit Print Button Labels
L4 Extension (2 5
a User (27) Import Templates in Manager
-8 Group (1) License Migration
=--B% Short Code (B3] |
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In the pop-up window that appears, select the directory where the template file was
copied in Step 1, then click OK.

Browse For Folder X

Select a folder to import templates from -

‘ Desktop
@ Onelrive

a Tester
A This PC
s Libraries
¥ Metwork
»§ Homegroup
[E5] Control Panel

& Recycle Bin

Cancel

After the import is complete, a final import status pop-up window will appear stating
success or failure (not shown). Click OK (not shown) to continue.

Note - Within Avaya IP Office Manager menus, the template directory may be accessed
by navigating to C:\Program Files\Avaya\lP Office\Manager\Templates. However,
the template directory is physically located in the User Access Control Virtual Store area
of Windows. To view the directory from outside Avaya IP Office Manager (e.g.,
Windows Explorer), replace the C: portion of the template path above with
%UserProfile%\AppData\Local\VirtualStore.
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3. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane,
and select New From Template - Open File.

IP Offices = s|
@& BOOTP (3) SIP Line Transport SIP URI VolP  T38 Fax SIP Cf
[-4# Operator (3)
E...:..,.:I, Aﬂant'r”r'ihf e N 17
B Sy 1] New N
T_‘:ﬁ 1 10.32.12
- Cg i Cut Ctrl+ X
# Ex 53 Copy Ctrl+C § I:
a Us
u. Gl B2y Paste Ctrl+V SIp
g Shi 2 Delete Ctrl+Del —
hﬂ; RA " Validate
-4 Ing Connect To... Ctrl+T
#ﬂ W.J| Mew from Template 3 " Open from file
e Export as Templat '
L T port as Template
Y Tin o o el ]

4. The subsequent pop-up window opens to C:\Program Files\Avaya\lP
Office\Manager\manager_files\template. Navigate to C:\Program Files\Avaya\lP
Office\Manager\Templates. The up arrow icon can be used to move up through the
directory tree.

U Open >
“ v <« manager_files » template v O Search termnplate g
Organize » Mew folder =~ [H 9
& OneDrive 2 MName Date modified Type
I This PC Mo items match your search.
[ Desktop
|::'| Documents
‘ Downloads
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5. Once reaching the correct directory, select Template Files (.xml) in the lower right
corner to ensure that .xml template files are displayed. From the list of template files,
select the one to be used and click Open.

" Open ¥

= v <« |P Office » Manager » Templates v | @ Search Templates o
Organize = Mew folder -~ [H 0

IPO ~ MName Date modified Type
OutbdCall96x1-(

SBCE

=] VFDE_IPO10.xmI 472172017 1202 PM - XML Document

Screens
@ Onelrive

& This PC
[ Desktop

=] Documents

" Downloads

J‘) Music

= Pictures

B videos

‘am Local Disk ()

¥ MNetwork v <

File name: | VFDE_IPC10.xml v| |Temp|ate Files (*xml) ~

A final status pop-up window will appear stating whether the trunk creation was a
success or failure (not shown). Click OK (not shown) to continue.

6. Once the SIP Line is created, verify the configuration of the SIP Line with the
configuration shown in Sections 5.5.2 — 5.5.8.
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5.5.2. SIP Line — SIP Line Tab
On the SIP Line tab in the Details Pane, configure or verify the parameters as shown below.

Set the ITSP Domain Name to the SIP domain provided by VVodafone DE.

Check the In Service box. This makes the trunk available to incoming and outgoing
calls.

Check the Check OOS box. Avaya IP Office will use the SIP OPTIONS method to
periodically check the SIP Line.

Set the Refresh Method to Re-invite and the Timer (seconds) to On Demand.

Set the National Prefix, International Prefix, and Country Code to values appropriate
for the location. In the case of the compliance test, the National Prefix was set to 0, the
International Prefix was set to 00 and the Country Code was set to 49 (Germany).
Enter a Description for the trunk (optional).

Set the Incoming Supervised REFER field and Outgoing Supervised REFER field to
Never since Vodafone does not support the REFER method.

Default values may be used for all other parameters.

—

IP Offices ‘ = SIP Line - Line 21 ek X v <>
- R BOOTP (9) SIP Line Transport SIP URI VolP  T38 Fax SIP Credentials SIP Advanced Engineering
-4 Operator (3)
=% Atlantic City Line Number 21 S In Service
=559 System (1)
-1 Line (27) | ITSP Domain Name avadeugm.arcor.de Check 005
F-+2» Control Unit (4)
4 Extension (25) Local Domain Name
- User (27) "
+__§“ Group (1) URI Type sSIp o Session Timers
- B% Short Code (65) " Refresh Method Re-invite ~
@ Service (0] Location Cloud
=l RAS (1) Timer (sec) On Demand
+"e Incoming Call Route (;
4§ WAN Part (0) ]
25 Directory (0) Prefix | |
171 Time Profile (0) . 0
- Firewall Profile (1) National Prefix | |
=il IP Route (4)
Internat | Prefi )
~- il Account Code (0) mernational Frefe | |
% License (30) Country Code |49 | Redirect and Transfer
il Tunnel (0 | ing S iced REFER N -
& ﬁ‘, User Rights (8) Mame Priority System Default 7 ncoming supervise: ever
- ARS (13) . . 9
&8 Location (0) Description |Vndafnne DE w/'o SBCE || Outgoing Supervised REFER e
“ Authorization Code ([ Send 302 Moved Temporarily [
Outgeing Blind REFER O
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5.5.3. SIP Line - Transport Tab

Select the Transport tab. Set or verify the parameters as shown below. UDP was used for the
signaling connection between Avaya IP Office and the service provider.

e Setthe ITSP Proxy Address to the IP address of the Vodafone DE SIP Trunk service.

e Set Layer 4 Protocol to UDP.

e Set Use Network Topology Info to None.

e Set the Send Port and Listen Port to 5060.

e Default values may be used for all other parameters.

-
i
-

SIP Line - Line 21

ek -8 X v <>

SIP Line Transpert SIP URI VolP

T38 Fax SIP Credentials 5IP Advanced Engineering

Use Metwork Topology Info

ITSP Proxy Address |192.168.49.191 |
Metwork Configuration
Layer 4 Protocol LUDp ~ Send Port 5060 =

MNone w~ Listen Port 3080

Explicit DMNS Server(s) 0
Calls Route via Registrar

Separate Registrar |
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5.5.4. SIP Line — SIP Credentials

The Vodafone DE SIP Trunk Service does not require SIP credentials for registration or
authentication so the SIP Credentials tab has no entry.

i= SIP Line - Line 21 =R IR AR ARRE
SIP Line Transport SIP URI VolP  T38 Fax 3IP Credentials SIP Advanced Engineering
Index User Mame Authentication Mame Contact Expiration (mins) Register Add...
Remove
Edit...
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5.5.5. SIP Line - SIP URI Tab

The set of SIP URI entries define which incoming calls will be accepted on the line and provide
configuration control of various SIP headers for outbound calls. A single SIP URI can be used
for both incoming and outgoing calls but this requires that the SIP Name setting on the User -
SIP tab (used in the From header for outbound calls) must match exactly with what the service
provider sends in the Request-Line for inbound calls.

To create the entry for inbound and outbound calls, select the SIP URI tab, then click the Add
button and the New Channel area will appear at the bottom of the pane. The entry was created
with the parameters shown below:

Set Local URI, Contact and Display Name to Internal Data. For outbound calls, these
settings will populate the user portion of the From and Contact headers as well as the
display name with the contents of the User = SIP tab (Section 5.7). The From header is
populated from the SIP Name field, while the Contact header and Display Name are
populated from the Contact and Display Name fields respectively. The User - SIP tab
is only present if a trunk in the system has a SIP URI using Internal Data. The Local
URI setting also impacts inbound calls. In this case, an inbound call is only accepted if
the user portion of the inbound INVITE Request-Line header matches a value configured
on the system for a user (User = SIP), hunt group (Hunt Group = SIP) or voicemail
(System => Voicemail).

Under Identity, set Identity to Internal Data and Header to P Asserted ID. This
enables the sending of the P-Asserted Identity (PAI) header in each outbound INVITE.
The user portion of the PAI header will be populated from the SIP Name field on the
User = SIP tab (Section 5.7).

Under Forwarding and Twinning, set Send Caller ID to Diversion Header. With this
setting, Avaya IP Office will include the Diversion header for calls that are forwarded or
directed via Mobile Twinning out the SIP Line. The Diversion header will contain the
redirecting party which is a DDI provided by the service provider.

Set Diversion Header to None. This disables the sending of the Diversion header in each
outbound INVITE. The Diversion header is only sent for Forwarding and Twinning as
described above.

For the Registration field, select 0: <None> from the pull-down menu.

Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line in Section 5.8.1. Similarly, associate the line to an outgoing line
group using the Outgoing Group field. The outgoing line group number is used in
defining Automatic Route Selection (ARS) or short code entries for routing outbound
traffic to this line in Section 5.6. For the compliance test, a new incoming and outgoing
group 21 was defined that only contained this line (line 21).

Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.

Click OK.
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7

SIP Line -Line 21*

SIP Line Transport 3P URI volp

T38 Fax SIP Credentials SIP Advanced Engineering

URl  Groups Leocal URI

Contact

Display Mame  Identity

Header Originator Mumber

Mew URI
Local URI |Use Internal Data V|
Contact |Use Internal Data V|
Display Name |Use|nterna| Data V|
Identity
Identity ‘Use Internal Data V|
Header P Asserted ID w

Forwarding And Twinning
Originataor

Mumber

Send Caller D

Diversion Header

Outgeing Group 21

Max Seszions

Diversion Header |NDHE w
Registration 0: <MNone> w
Incoming Group 21 ~

& - _‘ﬂ K v« >
Send Caller Add... “
Remowve
Edit...
OK
Cancel
W

If using Internal Data, additional SIP URIs may be required to allow inbound calls to numbers
not associated with a user, such as a short code. These URIs are created in the same manner as
shown above with the exception that the incoming DDI number is entered directly in the Local
URI, Contact, and Display Name fields.

CTM; Reviewed:
SPOC 7/24/2017

Solution & Interoperability Test Lab Application Notes
©2017 Avaya Inc. All Rights Reserved.

28 of 43
VFDE_IPO10



5.5.6. SIP Line - VoIP Tab

Select the VolIP tab, to set the VVoice over Internet Protocol parameters of the SIP line. Set or
verify the parameters as shown below.

For Codec Selection, select System Default from the pull-down menu to use the default
list of codecs. A list of the codecs in their current order of preference will be shown on
the right in the Selected column. To use a custom list of codecs, select Custom for
Codec Selection. Next, move unwanted codecs from the Selected column to the Unused
column. Lastly, move the codecs up or down the list in the Selected column to achieve
the desired order of preference. The example below shows the codecs used for the
compliance test. One way to avoid the issue with Avaya 96x1 H.323 phones using SRTP
and G.729 documented in Section 2.2 is to exclude G.729 from the Selected column.

e Uncheck the VoIP Silence Suppression box.

e Check the Re-invite Supported box.

e Verify that Allow Direct Media Path is unchecked.

e Check the PRACK/100rel Supported option box. This setting enables support by
Avaya IP Office for the PRACK (Provisional Reliable Acknowledgement) message on
SIP trunks.

e Setthe Fax Transport Support to G.711. T.38 fax is not supported by the VVodafone
DE SIP Trunk Service.

e Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

e Set Media Security to Disabled. This setting will use unencrypted media (RTP)
between Avaya IP Office and the service provider.

e Default values may be used for all other parameters.
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[

i= SIP Line - Line 21 ef - X | w | <]|>

SIP Line Transport SIP URI VelP  T38 Fax SIP Credentials SIP Advanced Engineering

| ] VolP Silence Suppression |

[ Lecal Hold Music

Codec Selection Custom s | Re-invite Supported |
U d Selected
nuse Flects [ Codec Lockdown
G.711 ULAW 64K oo (G711 ALAW 6K
722 64K 6.729(a) 8K CS-ACELP [ Allow Direct Media Path |

G.723.1 6K3 MP-MLQ Force direct media with phones

| 4 PRACK/100rel Supported |

L4
[ 6.711 Fax ECAN
-
Fax Transport Support | G711 ~
DTMF Support RFC2833 -
Media Security Disabled ~
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5.5.7. SIP Line — T38 Fax Tab
Vodafone DE does not support T.38, so no changes are needed on the T38 Fax tab.

5.5.8. SIP Line — SIP Advanced
Select the SIP Advanced tab. Set the parameters as shown below.

e Set Call Routing Method to Request URI. Avaya IP Office will route calls based on
the contents of the Request URI in the incoming INVITE.

e Check the Use + for International box. In outbound SIP headers, the user dialed
international code (in this case 00) will be replaced with a + sign. For example,
0019085551234 will become +19085551234.

e Check the Use PAI for Privacy box. By default, Avaya IP Office uses the P-Preferred-
ID header (PPI) for privacy calls. When this box is checked, the PAI header is used
instead.

Click the OK button at the bottom of the page (nhot shown).

= SIP Line - Line 21

SIP Line Transport SIP URI VolP  T38 Fax SIP Credentials 5IP Advanced Engineering

Addressing Media
Association Method By Source [P address b Allow Empty INVITE O
Send Empty re-INVITE |
Call Routing Method Ri <t URI ~
a7 outing ° == Allow To Tag Change |
Suppress DNS SRV Lookups O P-Early-Media Support Mone ~
Send SilenceSupp=0Off |
Identity
Use "phone-contexd” ( Media Connection Disabled -
Add user=phone O Preservation
Use + for International Indicate HOLD |
Use PAI for Privacy
Use Domain for PAI O Call Control
S Fi d PAI/Diversi =
wap From and PAI/Diversion L] Call Initiation Timeout (s) 4 z
Caller ID from From header |
Send From In Clear O Call Queuing Timeout (mins) |3 S
Cache Auth Credentials Service Busy Response 486 - Busy Here ~
User-Agent and Server Headers I:I on Mo User Responding Send | 408-Request Timeout ~
send Location Info WS Action on CAC Location Limit | Allow Voicemail ~
Suppress Q.830 Reason O
Header
Emulate NOTIFY forREFER [
Mo REFER if using Diversion ]
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5.6. Short Codes

A short code is a dial pattern that triggers a specific function. A short code is used by the caller
to route outbound traffic to a specific trunk or ARS route. To create a short code, right-click on
Short Code in the Navigation Pane and select New (not shown). On the Short Code tab in the
Details Pane, configure the parameters as shown below.

¢ Inthe Code field, enter the dial string which will trigger this short code, followed by a
semi-colon. In this case, 9N;. This short code will be invoked when the user dials 9
followed by any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value forms the user portion of the Request-Line and To
headers of an outbound INVITE.

e Setthe Line Group Id to the outgoing line group number defined on the SIP URI tab on
the SIP Line in Section 5.5.5. Alternatively, the Line Group ID may point to an ARS
route which allows for more comprehensive routing decisions based on the number dialed
and available trunks. More information on using ARS may be found in [2].

Click the OK button (not shown).

IP Offices | E; ON;: Dial B - <[>
2R BOOTP (3) Short Code
-4 Operator (3)
5% Atlantic City Code |on; |
+-4550 System (1)
+-T7 Line (23) Feature Dial ~
#1-<2+ Contrel Unit (3)
448 Extension (25) Telephone Mumnber |N |
-
+=ﬂ g::rulg) Line Group 1D |21 v|
+“ Locale ~
-8 Service (0)
+afy RAS (1) Force Account Code O
+e Incoming Call Route (i} popee Authorization Code Il
~$8 WAN Port (0)
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Optionally, add or edit a short code that can be used to access the SIP Line anonymously. In the
screen shown below, the short code *67N; is illustrated. This short code is similar to the 9N;
short code except that the Telephone Number field begins with the letter W, which means
“withhold the outgoing calling line identification”.

In the case of the SIP Line documented in these Application Notes, when a user dials *67 plus
the number, Avaya IP Office will include the calling number in the P-Asserted-Identity (PAI)
header and will include the Privacy: Id header.

= *67N:: Dial £ - X | v < :~|
Short Code

Code “67N; |

Feature Dial w

Telephone Mumber |WN |

Line Group ID |2'| V|

Locale w

Force Account Code ]

Force Authorization Code [
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5.7. User

If the SIP Line is configured to use Internal Data in Section 5.5.5, then configure the SIP
parameters for each user that will be placing and receiving calls via the SIP line. To configure
these settings, first navigate to User - Name in the Navigation Pane where Name is the name of
the user to be modified. In the example below, the name of the user is Extn243. Select the SIP
tab in the Details Pane. The values entered for the SIP Name and Contact fields are used as the
user part of the SIP URI in the From and Contact headers for outgoing SIP trunk calls. The
value entered in the SIP Name field is also used in the PAI and Diversion headers.

The example below shows the settings for user Extn243. The SIP Name and Contact are set to
one of the DDI numbers assigned to the enterprise from VVodafone DE in international format.
The SIP Display Name (Alias) parameter can optionally be configured with a descriptive name.

If all calls involving this user and a SIP Line should be considered private, then the Anonymous
box (not shown) may be checked to withhold the user’s information from the network.

Click the OK button (not shown).

IP Offices \:E Extn243: 243 - X v <

:a EJOOTI: (333] Voice Recording  Button Proegramming  Menu Programming  Mobility  Group Membership
-4 Operator
529 Atlantic City User Voicemail DND Short Codes  Source Numbers Telephony Forwarding  Dial In

+*“~ System (1) Announcements 5P Personal Directory  Web Self-Administration

+- 4 Line (23)

+ = Control Unit (3] SIP Mame |+496913 42 |

+- 4 Extension (25)

+= User (27) SIP Display Mame (Alias) |Ex‘tn243 |

+:ﬁ Group (1)

418X Short Code (65) Contact |+4969130 2 |

- Service (0)
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5.8. Incoming Call Route

An incoming call route maps an inbound DDI number on a specific line to an internal extension.
This procedure should be repeated for each DDI number provided by the service provider. To
create an incoming call route, right-click Incoming Call Routes in the Navigation Pane and

select New.

5.8.1. Incoming Call Route — Standard Tab
On the Standard tab of the Details Pane, enter the parameters as shown below.

e Set the Bearer Capacity to Any Voice.
e Setthe Line Group Id to the incoming line group of the SIP line defined in Section

5.5.5.

e Set the Incoming Number to the incoming number on which this route should match.
The matching is performed from right to left. Thus, the local number was entered
without the 0 prefix so it would match the number in local format (06913xxxxx42) or
international format (+496913xxxxx42).

e Default values can be used for all other fields.

----- & Tunnel (0)
E-§ig User Rights (8)

IP Offices |E 21 69130 w42 ef -8 X[ v <>
- & BOOTP (3) Standard Voice Recording Destinations
B4 Operator (3)
-3 Atlantic City
- S?rstem U Bearer Capability Any Voice v
T4 Line (25)
-+ Control Unit (3) Line Group ID 21 v]
(-4 Extension (25)
EJ---& User (27) Incoming Mumber |6913 42 |
-4 Group (1)
G-8% Short Code (65) Incoming 5Sub Address | |
----- B service () i
- RAS (1) Inceming CLI | |
E:I---@ Incoming Call Route Locale -
----- B2 WAN Port (0)
""" @ Directory (0) Priarity 1- Low v
----- £1% Time Profile (0)
@@ Firewall Profile (1) Tag | |
- [ll IP Route (4) _
..... am Account Code (0) Hold Music Source Systern Source ~
----- % License (30) ) )
Ring Tone Override |NDHE V|

5.8.2. Incoming Call Route — Destinations Tab

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. Click the OK button (not shown). In this example, incoming calls to this
number on line 21 are routed to extension 243.
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= 21 69138 w42 £f - X v i<

Standard Voice Recording L

TimePrafile Destination Fallback Extension

3 Default Value 243 Extn243 e w

Incoming Call Routes for other direct mappings of DDI numbers to Avaya IP Office users listed
in Figure 1 are omitted here, but can be configured in the same fashion.

5.9. Save Configuration
Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.

Save Configuration — >

IP Office Settings
Atlantic City

Configuration Reboot Mode
®) Merge

) Immediate

() When Free

) Timed

Reboot Time

12:01 =

Call Barring

0K Cancel Help
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6. Vodafone DE SIP Trunk Service Configuration

Vodafone DE is responsible for the configuration of the Vodafone DE SIP Trunk Service. The
customer will need to provide the IP address used to reach the Avaya IP Office at the enterprise.
In the case of the compliance test, this is the public IP address of the Avaya IP Office LAN2
interface. VVodafone DE will provide the customer the necessary information to configure Avaya
IP Office including:

e Vodafone DE SIP proxy IP address

e Transport protocol and port

e SIP Domain

e Supported codecs and order of preference
e DDI numbers

In addition, to configure any possible firewall/security devices at the enterprise, Vodafone DE
will provide the IP address and port of any media sources that will need access to the enterprise.
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7. Verification Steps

This section provides verification steps that may be performed in the field to verify that the
solution is configured properly.

7.1. Avaya IP Office

Avaya IP Office has several tools that can be used to verify and troubleshoot the system
operation. Two of these tools are described in the following subsections.

7.1.1. System Status

The System Status application is used to monitor and troubleshoot Avaya IP Office. Use the
System Status application to verify the state of the SIP trunk. System Status can be accessed
from Start = All Programs - IP Office - System Status.

The following screen shows an example Logon screen. Enter the Avaya IP Office IP address in
the Control Unit IP Address field, and enter an appropriate User Name and Password. Click
Logon.

+J Avaya IP Office System Status — O =

AVAyA IP Office System Status

Help Exit About

Online | Offline

Logon

Control Unit IP Address: [kl i

Services Base TCP Port: ELl:LE]

LT R ET LH Admini strator

Password:

H Auto reconnect

M Secure connection

CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 38 of 43
SPOC 7/24/2017 ©2017 Avaya Inc. All Rights Reserved. VFDE_IPO10



Select the SIP line under Trunks from the left pane. On the Status tab in the right pane, verify
the Current State does not indicate an error. The state of Idle indicates the channel does not
have an active call.

Status  Utilization Summary Alarms

SIP Trunk Summary

Line Service State:
Peer Domain Mame:

Resolved Address:

In Service
avadeugm.arcor.de
192.168.49.191

Line Mumber: 21
Mumber of Administered Channels: 10
Mumber of Channels in Use: 0
Line: 22 Administered Compression: G711 A, G729 A
Loz Enable Faststart: Off
Silence Suppression: Off
Media Stream: RTP
Layer 4 Protocol: UDP
SIP Trunk Channel Licenses: 128 . -
SIP Trunk Channel Licenses in Use: 0
5IP Device Features:
Current Time in  Remote Co... Conne... C Round Transmit Transmit
State Media A... TripD... ] Jitter Packe...
1 Idle J03:15:51
2 Idle J03:15:51
3 Idle J03:15:51
4 Ide |03:15:51
5 Ide |03:15:51
3] Ide |03:15:51
7 Ide J03:15:51
g Ide J03:15:51
9 Idle J03:15:51
10 Idle J03:15:51
Trace Trace All Pause Ping Call Details Graceful Shutdown Force Qut of Service Print... Save As...
3 Online )

Select the Alarms tab and verify that no alarms are active on the SIP line.

Alarms

Status  Utilization Summary

Alarms for Line: 21 SIP avadeugm.arcor.de

Last Date Of Error Ocourrences Error Description

39 0f 43
VFDE_IPO10
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7.1.2. Monitor

The Monitor application can also be used to monitor and troubleshoot Avaya IP Office. Monitor
can be accessed from Start > All Programs - IP Office - Monitor. The application allows
the monitored information to be customized. To customize, select Filters = Trace Options.

The following screen shows the SIP tab, allowing configuration of SIP monitoring.

CTM; Reviewed:
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All Settings *
T1 | PN | WM | SON | Jade
&M | cal | DTE | ECont | FiameRelay | GOD | H.323 | Interface
ISOM | Kep/Lamp | Diectory | Media | FFF | B2 | Fouting | Services  SIP lSystem]
Events
¥ Sip |Standard - [# STUN [~ SIP Dect
Packets
[ SIF Reg /Opt Rx [ SIP Mizc Ax
[~ SIF RegOpt Tx [ SIP Mizc Tx
[~ SIF Call R= [~ Crn Motify Fi=
[~ SIPCall T [~ Crn Matify T=
[v SipFRx IP Filter [man. nnn.anm. sien)
WV SipTx |
Default AII| Clear Al | Tab I:Iear.-’-‘«||| Tab Set A||| CECT] cancel
Save File | Load File | Load Partial File‘ Select File ‘
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8. Conclusion

These Application Notes describe the configuration necessary to connect Avaya IP Office 10.0 to
the Vodafone DE SIP Trunk Service. The Vodafone DE SIP Trunk Service is a SIP-based Voice
over IP solution for customers ranging from small businesses to large enterprises. It provides a
flexible, cost-saving alternative to traditional hardwired telephony trunks. The VVodafone DE SIP
Trunk Service passed compliance testing. Please refer to Section 2.2 for any
observations/exceptions.

CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 41 of 43
SPOC 7/24/2017 ©2017 Avaya Inc. All Rights Reserved. VFDE_IPO10



9. Additional References

This section references documentation relevant to these Application Notes. In general, Avaya
product documentation is available at http://support.avaya.com.

[1] Deploying Avaya IP Office Platform IP500 V2, Document Number 15-601042, Issue 319,
August 3, 2016.

[2] Administering Avaya IP Office Platform with Manager, Release 10, September 2016.

[3] Using System Status, Document Number 15-601758, Issue 11e, July 7, 2016.

[4] Administering Avaya IP Office Voicemail Pro, Document Number 15-601063, Issue 11e,
July 20, 2016.

[5] Using IP Office System Monitor, Document Number 15-601019, Issue 07b, June 9, 2016.

Additional Avaya IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/
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Avaya and the Avaya Logo are trademarks of Avaya Inc. All trademarks identified by ® and
™ are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks
are the property of their respective owners. The information provided in these Application
Notes is subject to change without notice. The configurations, technical data, and
recommendations provided in these Application Notes are believed to be accurate and
dependable, but are presented without express or implied warranty. Users are responsible for
their application of any products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
DevConnect Program at devconnect@avaya.com.
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